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Scope and Intended Use: VIDEOS Small Animal
Examples
The instructional videos and this workbook are intended as a tutorial for novice users of PMOD.
Exercises are organized into sections for each of the major PMOD tools as well as for database
management. The exercises (video plus workbook section) provide detailed descriptions of typical
tasks accomplished with PMOD, including additional background information where possible.
We recommend that users start at the beginning of each section and work through the descriptions
step-by-step. For more specific information, please refer to the product documentation which is part
of any PMOD installation or which is available online: www.pmod.com > Support > Documentation.
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Example Data and PMOD Installation
The example data for the exercises covered by this workbook are distributed as an optional part of
any new PMOD installation and are contained in the databases called Demo and BrukerPCI.
Users who own a PMOD installation can use that installation to perform the training tasks, as long as
the training databases were installed (contact us on support@pmod.com for assistance adding the
training databases to your installation later). To perform tasks with PMOD tools not included in their
purchased license, we recommend requesting a trial installation.
Users working with a trial PMOD installation should download the example databases and install them
together with the program. Note that the results produced with trial licenses cannot be saved.
However, save-enabled trial licenses are available on request.
For loading the example data, the Database data format must be used. To try similar work with your
own data, we recommend using the processes described for DICOM and other image formats in
Section 1 below.
All example images in the database are in DICOM format, calibrated, decay corrected and with
correct timing information. Vector data such as blood activities are text files that conform to the
requirements of the PMOD tools. You can export them to the file system for inspection.
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Copyright and Disclaimer
The example data provided in the Demo database are by courtesy of the following institutions.
CPFPX data: Institute of Medicine, Research Centre Jülich, 52425 Jülich, Germany; Dr. A. Bauer.
DASB data: Molecular Imaging Branch, National Institute of Mental Health, Bethesda, USA; Dr. M.
Ichise.
Mouse FDG PET and MR data was provided courtesy of the Werner Siemens Imaging Center,
University of Tübingen, Tübingen, Germany; Dr. K. Herfert.
All other data: Nuclear Medicine, University Hospital, Zürich, Switzerland; Dr. A. Buck.
Note that the original data have been processed and optimized for training purposes.
The example data provided in the BrukerPCI database are from Bruker demo sites. Two additional
external datasets are included in the BrukerPCI database. The rat PET data was provided courtesy
of the Cyclotron Research Center, University of Liege, Liege, Belgium; Dr. A. Plenevaux. The
mouse PET data was provided courtesy of the Werner Siemens Imaging Center, University of
Tübingen, Tübingen, Germany; Dr. K. Herfert.
IMPORTANT:
The data from the Demo/BrukerPCI databases may only be used for PMOD/Bruker training
purposes. The owners of the original data reserve all rights regarding any type of public use of this
data. Particularly, the data may not be used for any kind of publication purposes without getting
written consent.
The content of this workbook is proprietary and may not be reproduced without permission of
PMOD Technologies. It corresponds to the functionality of PMOD at the time of writing and can be
changed without notice.

PMOD is a software
FOR RESEARCH USE ONLY (RUO)
and must not be used for diagnosis or treatment of patients.
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Section 1: Image Viewing, Processing and Basic
Analysis (PVIEW)

4.1

Image loading
PMOD will load all widely used image formats (e.g. DICOM, nifti, interfile, analyze). DICOM data is
best loaded using the dedicated DICOM loader, while the AUTODETECT loader is designed for
other formats. Additionally, image data may be saved to PMOD’s built-in DICOM Database. DICOM
image files can be directly imported into a PMOD Database, and other formats will be converted to
DICOM when saved to a Database. The Pmod Database is created by default in all PMOD
installations, and a Demo database is created when the demo data is included during installation.
Creation of new databases is described later in this workbook.

4.2

S1-exercise 1: Loading images from the database
1. Image series stored in the Database can be directly selected via the interface on the DB
Load tab.
2. It is displayed by default when each tool is started.
3. The active database can be selected via the DB Name panel at the top of screen.
4. The Subject is selected on the Subjects tab, and Series available for that subject are
displayed on the Series tab.
5. Select the BrukerPCI database, then subject Mouse_1 (Bone NaF).
6. Select the PET WB series and Add it to the Selected for Loading tab.
7. The PET series is loaded on the View tab, and displayed in the 3 Orthogonal Planes layout.
8. Clicking on any of the planes displayed triangulates that position in the other planes.
9. Try loading multiple images at the same time. The images open will be listed in the top right.

4.3

S1-exercise 2: Loading DICOM images
1. New datasets can be loaded without having to clear existing data.
2. On the DB Load tab there is a dedicated DICOM button in the lower right.
3. This opens the DICOM loader, which scans the currently selected folder for DICOM files.
4. The folder can be changed using the orange Change Folder button at the top of the dialog.
5. Select the folder USBdrive:/Pmod-Trial/Pmod/data/DICOM-example.
6. The DICOM loader scans the folder and displays any series available for loading.
7. Select the PET series and Load.
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4.4

S1-exercise 3: Loading images using format AUTODETECT
1. As a final comparison, try loading an interfile format image using the AUTODETECT load
button in the lower right of the DB Load tab.
2. Use the interface to select the folder USBdrive:/Pmod-Trial/Pmod/data/Interfile-example.
3. Select PET.hdr and Load.
4. PMOD automatically associates the header and image files and loads the data (.hdr and
.img).
5. Compare the Gray, Cold and Hot color tables.

4.5

S1-exercise 4: Image display and capture
Creating pleasing captures for presentation and publication is an essential part of preclinical
imaging research. PMOD provides convenient tools for image and movie capture throughout the
software. The functions introduced in the View tool described below are conserved across all of the
PMOD tools.
1. Select Subject rat_1 from the BrukerPCI database.
2. Select the T2 turboRARE 3D series, Load.
3. On the Layouts tab, change from Orthogonal Planes to Y.
4. Change from 1x1 to 4x4.
5. Switch back to the General Image Manipulation tab and check the effect of moving the Slice
Selection slider.
6. Make the display skip 2 slices between displayed slices by setting the Slice Step to 3.
7. Use the mouse wheel or Slice Selection slider to adjust the display until the complete rat
brain is covered in the display.
8. Using the Capture icon at the lower right corner of the image display, select Capture
Display (note keyboard shortcut CTRL+E).
9. Select the Clipboard format and Full Display.
10. The Set button saves the capture to the OS clipboard, ready for paste into other programs
such as MS Powerpoint.
11. To include a color bar, select Scientific Output from the Capture menu (note keyboard
shortcut CTRL+O).
12. Activate Color Bar, choose Vertical, and Annotated.
13. Select 768 pixel Output Width.
14. Confirmation opens the Scientific Capture Dialog, and the color bar can be seen on the
right-hand side.
15. Capture opens a similar format selection, where again Clipboard can be selected.
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4.6

S1-exercise 5: Dynamic images and capturing tracer kinetics
1. Select subject rat_3 from the BrukerPCI database.
2. Select the dynamic PET WB series, Load.
3. Right click in the Image Display Area, then select Layout > Orthogonal.
4. Set the lower/upper color table thresholds to 0/800.
5. On the General Image Manipulation tab, reset the Slice Step to 1.
6. Use the Time Frame slider to move through the available time frames.
7. This can be automated, and a movie created, on the Movies tab.
8. Select Frames, and start the movie using the white arrow pointing right.
9. It is still possible to triangulate new positions in the Image Display Area, and adjust the
movie speed using the smaller black arrows in the Movies tab.
10. Activating the Filmstrip icon in the Movies tab changes the play mode to once-through, and
will produce a Save Video dialog when the movie is next started.
11. Start the movie again, and view the Save Video dialog.
12. Select Animated GIF (convenient for embedding into Powerpoint), 8 frames/sec, GIF
continuous loop, Active area (e.g. sagittal plane), then Start.
13. After playing/creating the movie, the Database Save dialog appears.
14. To save the GIF in a folder for use in Powerpoint, select Save To File System.
15. Navigate to a suitable folder, enter a file name, and Save.
16. Additionally, the multi-slice layout can be converted to multi-frame.
17. On the Layouts tab, select Y, then choose the multi-slice layout RxN and set 1x8.
18. The slice and time radio buttons then become active. Select T.
19. Once again, a gap between displayed time frames can be configured. On the General
Image Manipulations tab, enter a value of 2 in the Frame Step box, then use the mouse
wheel or time frame slider to adjust the display on screen. (hint: slice 72 shows the brain
and kidneys, as a good demonstration of the evolving activity over time).
20. The 2D illustration of the time series can be captured using the Capture icon at the lower
right of the Image Display area as before.

4.7

S1-exercise 6: Image cropping and saving
1. Clear the workspace in the View tool.
2. Return to the DB Load tab and select rat_3, dynamic PET WB again. Load.
3. If necessary, return to the Orthogonal planes display.
4. There is a dedicated workflow for image cropping in the lower right of the View tab.
5. Set the color table lower/upper thresholds to 0/800 and select the final time frame.
6. We will crop the brain from the image so that it could be used more effectively in batch
processing later.

Workbook for Instructional Videos - Small Animal Examples

© 2020 PMOD

9

Section 1: Image Viewing, Processing and Basic Analysis (PVIEW)

7. Check the Crop checkbox and change the Species selection to Rat. An appropriate size
crop box is displayed in yellow, centered on the cursor. The center point can be adjusted
by triangulating a new point in the Image Display, and the box size adjusted using the
arrows in the Crop workflow dialog.
8. Center the box on the brain, and adjust the box to 34 / 28 / 40 mm.
9. Cropping will be performed when the workflow is followed to VOIs (Volume-Of-Interest
analysis), or it can also be applied using the Crop icon.
10. Apply cropping using the Crop icon.
11. Reset the color table upper threshold to 800 and select the last time frame.
12. Turn off the Cropping workflow checkbox.
13. The cropped image can be saved in any supported format.
14. Select Save: Database.
15. A Save dialog opens, in which the database can be selected and parts of the DICOM
header edited using Edit Info.
16. Select Edit Info.
17. Editing the Series Description is a useful way to add information to entries in the database.
Add [brain crop] to the Series Description, confirm and Save.
18. Go to the DB Load tab and view the new entry for rat_3.
19. The Save menu allows several other formats to be selected.
20. Select Save: Interfile.
21. A different save dialog is opened. The folder in which to save the data can be defined in a
file browser opened using the Save Path icon.
22. The Transfer Syntax is important for non-DICOM formats. PMOD tests the data to determine
whether pixel values will lose precision using particular syntax. A yellow warning icon is
displayed if precision will be lost, otherwise [transfer syntax validated] is displayed. If in
doubt, use the Float (LE) option!
23. Save the image in Interfile format (Two files) to an appropriate folder.

4.8

Volumes-of-Interest (VOI)
The extraction of information from our images relies on volumes-of-interest (VOIs). The
drawing/definition of VOIs constitutes segmentation of regions/organs within the subject. This
process may be driven by tracer uptake, or by anatomical information where available (see Fusion
workflows later). VOIs are built from planar polygons called “contours” (CTR). Contours can be
defined in coronal, sagittal and horizontal planes. All contours from a given VOI in a single plane are
grouped and considered as region-of-interest (ROI). Many VOI drawing/definition tools are available
in PMOD. Where possible, (semi-) automated methods are favored, including methods with careful
control of segmentation thresholds. Fully manual methods are always available as backup, for
example where image contrast is poor and automatic methods fail. A number of examples are
demonstrated below, and further examples will follow in the Fusion and Automated Segmentation
sections.
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4.9

S1-exercise 7: Image processing and VOI analysis
1. Load the original rat_3 dynamic PET WB from the BrukerPCI database again.
2. Creating an average of time frames from a certain range is a useful way to delineate
organs with high tracer uptake, even when there is no trapping of the tracer.
3. In this case, the organs with most prominent FDG uptake are the brain, heart, kidneys and
the Harderian glands (between brain and eyes). We will use the kidneys as an example for
VOI drawing and extraction of statistics.
4. Activate the 2D MIP display in the Image Display area, and invert the Gray color table. The
MIP is recalculated as each time frame is displayed.
5. Check frames 8-13. In this time range the activity in the kidneys is relatively uniform (high
activity hot spots are just starting to appear in frame 13).
6. To properly understand which time range this represents, open the Series Information
dialog, then select Edit Frame Times. The dialog allows you to see the start and end times
for each time frame.
7. On the Tools tab, the second subtab allows averaging of either slices or frames, depending
on what is available. The default for a dynamic dataset is frames. Use the slider to select the
range 8-13.
8. Below the subtabs, the Replace checkbox determines whether the existing data will be
overwritten by the average created, or not. In this case, leave the box unchecked, then click
Run to calculate the average image.
9. Set the lower/upper color bar thresholds to 0/500, highlighting the activity in the kidneys.
10. Go to the VOIs page using the workflow button in the lower right.
11. As we are working with 3D data we will start with simple 3D VOIs. Create a 3D sphere
object in the left kidney. Use the 3D sphere object tool and 3 mm radius.
12. The sphere can be interactively expanded in x/y/z direction, and rotated around each axis.
13. Adjust the sphere into an ellipsoid and rotate it to approximate the left kidney.
14. Rename the VOI left kidney.
15. Use the New VOI button to create an empty VOI definition and immediately set the name to
right kidney.
16. Select the 3D Hot VOI tool and left click near the outer edge of the right kidney. The voxel
clicked becomes the threshold, and all connected voxels with higher activity are calculated
to create a 3D VOI.
17. Naturally neither of these VOIs is truly anatomically-derived, and direct clicking to select a
threshold is subjective. However, either method is suitable for rapid exploration of the data.
18. Calculate the Statistics for the currently active image (the average).
19. The Statistics Viewer is opened, and basic statistics for the two VOIs shown.
20. These results can be saved in PMOD’s *.voistat format, or Copied To Clipboard for easier
transfer into programs like MS Excel.
21. In fact, the default mode for calculation of Statistics is Selected Statistics. Expand the
Statistics menu to see the other available options. The statistics to be included in Selected
Statistics can be defined in a dedicated dialog.
22. Close the Statistics dialog.
23. The images available in the memory can be viewed via the list in the top right.
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24. Switch to the original dynamic series, then calculate Statistics again.
25. When a dynamic image is active, time-activity-curves (TACs) are calculated automatically.
26. Again, these can be saved in PMOD’s *.voistat format, but also as PKIN TACs (.tac) or
Copied To Clipboard.
27. The following exercises will illustrate additional VOI definition tools and typical use cases.

4.10 S1-exercise 8: VOI-based masking for improved 3D
rendering with CT data
1. A common use of VOIs is VOI-based masking, which can be used to prepare images for
presentation. This is common for most modalities. In the case of PET, high activity in the
bladder may be masked to allow presentation of the image with more appropriate focus on
tumor uptake. For CT, a common task is removal of the bed and tubing associated with
anesthesia and monitoring, improving MIP and 3D rendering of the animal. We will use
such CT “clean-up” as an example.
2. Load the CT WB from Subject mouse_5 (low dose PET/CT).
3. The MIP shows that the animal bones are the most dense part of the image, meaning that
rendering of the skeleton alone could be quite effective without masking. However, the bed
materials have a similar density to the animal soft tissues, which will preclude whole body
rendering (e.g. volume rendering).
4. When there is some separation between the animal and the bed materials (e.g. when some
foam padding was placed between bed and animal, separation with regular VOIs can be
straightforward. It is helpful when the surfaces of the bed are exactly parallel to the
reconstructed image planes, but PMOD’s reslicing tools can used if this was not the case.
5. The Reslicing tab allows the image to rotated and translated interactively.
6. Click and hold the central square marker to drag and translate the image.
7. Center the mouse in the bounding box.
8. Click and hold the small handle connected to the central marker to interactively rotate the
image. The handle can be extended for fine control.
9. Using the controls on the sagittal plane display, rotate the image to make the mouse cradle
itself parallel to the main axis (there is sufficient clearance between the animal and the
holding cell for masking despite non-parallel alignment).
10. Proceed to the VOIs tab.
11. Explore the image to understand the location of the forelimbs.
12. The left forelimb extends beyond the cradle and almost touches the outer cell. A custom VOI
shape is needed to avoid removing the limb during masking.
13. Use the Vertex Paintbrush tool to draw a 2D ROI around the animal on the coronal plane,
including the protruding forelimb. It may be useful to change the Image Display to show
only the coronal slice (z) for this operation. Leave sufficient space around the animal’s
body to later include the abdomen.
14. From the ROI tools, select ROI Apply to All.
15. Switch back to the Orthogonal Planes display.
16. Select the VOI tools Neutral Mode, and explore the image to see the now 3D VOI.
17. On the VOI Tools tab, select Mask voxels outside selected VOI.
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18. As we are masking CT data, the background value for air is -1000 HU.
19. This assumption can be tested using the Data Inspector.
20. Enter -1000 in the Mask outside VOI(s): by value box. Do not check Mask inside.
21. Allow a new image to be created, so that we can compare the masked to the original.
22. Save the masking VOI to the database.
23. Use the workflow button in the lower right to proceed to the Compare tab.
24. The third row can be switched off, and the MIP for both series activated.
25. The effect of masking is clear.
26. Save the masked version of the image to the database for later rendering (edit the Series
Description to help identify the masked series later).

4.11 S1-exercise 9: Isocontouring using a defined SUV threshold
1. Isocontouring is a very useful VOI definition technique as it allows careful control of the
voxel inclusion threshold, and the search area can be confined to a user-defined boundary.
It is particularly useful for PET/SPECT data where there is high tracer uptake in a given
region/organ, but it can also be used to segment bone/lungs/contrast-enhanced-lesions in
CT or clear contrast/enhanced areas in MR.
2. Load mouse_6, PET WB, from the BrukerPCI database (the various [CROP]-labeled series
are for later use in 3D rendering).
3. Activate the MIP display, and use an inverse Gray color table with thresholds 0/0.05.
4. The MIP reveals that FDG uptake is most evident in heart, kidneys, bladder and Harderian
glands, but there is also a xenograft lesion visible on the right side of the chest. We will use
isocontouring to segment this lesion without interference from high uptake in other organs.
5. From the image processing tools, select SUV image calculation.
6. A warning that the units are not correctly set to kBq/cc is displayed.
7. Such problems in the image data can be corrected using the Image Information dialog.
8. On the Edit tab, select kBq/cc under Value Units, then Set Units.
9. Select Edit Subject / Study Info.
10. In the Subject and Study Information dialog, select the SUV PARAMETERS tab.
11. Note that quite a lot of information is missing for this data (which was imported into the
database from Interfile format data).
12. Select Scan as Date/Time (of decay correction) and manually enter 2019-5-29 8-23-39
(this is the Study date/time from the STUDY / SERIES INFORMATION tab).
13. Copy the modified Scan Date/Time to the Image Decay Correction Date/Time. Note the
effect on the Dose at Image Decay Correction Time.
14. In order to calculate a typical SUV(body mass) image we also need a realistic body mass
for the mouse. Enter 0.025 kg.
15. Click OK and close the Image Information dialog.
16. Try SUV Image Calculation from the Image Processing Tools again.
17. Now the dialog opens, and the corrected SUV dose/time information is displayed.
18. Select OK (do not Replace).
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19. Once the calculation is complete, set the color table upper threshold to 5.
20. Open the Data Inspector and check the value of some voxels in the mouse. Note the new
units: g/ml{SUVbw}.
21. This process of correcting SUV information before being able to calculate such an image is
only necessary when information is missing from the image format/header. When all
information is recorded in the Study setup in PV360 and DICOM data is directly exported to
PMOD, the workflow will be substantially more efficient.
22. Proceed to the VOIs tab.
23. Triangulate the lesion in the display and zoom to factor 4.
24. To create a boundary for the isocontouring search algorithm, create a Sphere object VOI
around the lesion. It should not include any voxels from the heart (a radius of 7 mm is
effective). Interactively reposition the sphere if necessary.
25. Open the isocontouring dialog.
26. Click the Set Defaults button
27. Now that we have the image with g/ml{SUVbw} units we can use an exact SUV threshold for
segmentation, that could then be used reproducibly across all animals in a study.
28. Switch from Percentage threshold to Value, and enter a threshold of 0.6 g/ml. The VOI is
automatically updated.
29. Click OK, then calculate Statistics for this VOI.
30. Note that it is also possible to switch back to the original image and calculate the Statistics
in kBq/cc. The Statistics Viewer also allows a direct switch to SUV units when the SUV
information is complete.
31. Additional suggestions – try using isocontouring to segment the bladder and mask it from
the image.
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Section 2: Image Registration and Fusion (PFUS)
Fused image display is not only interesting for image presentation, but can also be valuable during
segmentation. Anatomical CT or MR images can be complementary to PET or SPECT, aiding in
organ/lesion delineation. Hybrid scanners may provide directly coregistered PET/SPECT and CT or
PET and MR images, removing the need for calculated coregistration. Nevertheless, in neurology
studies spatial normalization of the brain to VOI atlases may be desirable. Whether this is achieved
directly from PET/SPECT data, or using the anatomical MR or CT, PMOD’s fusion functionality is
required and allows the normalization result to be properly inspected. In longitudinal studies each
subsequent scan may be registered to the individual baseline, and PMOD supports “image algebra”
between such studies to aid in visualization of differences over time (Note: longitudinal image
registration is most successful for brain studies, while reproducible body/limb positioning is a major
hurdle in whole body matching).

5.1

S2-exercise 1: Fusion display of hybrid data and simple VOI
analysis
1. In the case of data from a recent hybrid scanner, the fusion workflow is reduced to fused
display of each modality, bringing the user efficiently to the VOI analysis step.
2. The Matching workflow in the Fuse It tool is broken down into five major steps: Loading of
the Input Image(s), Loading of a Reference Image and Matching of Input to Reference,
Inspection of the Matching Result, Image Algebra, and finally VOI Analysis.
3. When hybrid data will be most commonly analysed, it is useful to set the Hybrid workflow as
Default. This is performed in the Configuration for Fuse It.
4. Note that default color tables, and the volumes used for species recognition, are also
configured here.
5. With the Hybrid workflow set as Default, both Input and Reference image can be loaded
together. This is most effective from Database, or DICOM, where the series modality is
clearly identified.
6. Select mouse_6 from the BrukerPCI database, and Add the PET WB and CT series to the
Selected for Loading list. As seen in the Configuration dialog, the CT is automatically
loaded as Reference for such a PET/CT pair.
7. When Open is clicked, Fuse It loads the images, selects the Hybrid workflow, reslices the
PET to the resolution of the CT and jumps to the Comparison tab to display the alphablended fusion of the series in whole body layout.
8. In the top right the image controls are identical to the View tool as seen in the previous
Section. When fusion functionality is available, there are two copies of the image controls,
and an additional set of fusion controls immediately below.
9. The image controls labeled with a green spot correspond to the Input image, and green
labeling is used elsewhere to highlight controls for the Input image. Blue is used for the
Reference image.
10. Set the Input upper color table threshold to 800 to display more of the PET data (the image
is dominated by the high activity in the bladder).
11. The new slider below the image controls adjusts the alpha blending between Input and
Reference images, and shortcuts for 0/50/100% are color-coded green/blue to the right of
the slider.
12. Additional controls for choice of displayed images (when more than two are available),
layout shortcuts, and Capture shortcut are available on the right of the Image Display.
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13. To perform VOI analysis in fusion mode, use the shortcut to the VOIs page of the Matching
tab on the right lateral toolbar.
14. Note that here there are also two sets of image controls in the top right. When using
threshold-based VOI tools it is essential that the appropriate set of controls is active (i.e. to
use the Hot 3D one-click tool on a hot-spot of activity in the PET image, make sure that the
Input image controls are active.
15. We will use the same automatic isocontouring method as in the last exercise of the previous
Section.
16. Triangulate the xenograft tumor on the right side of the chest, then zoom in by factor 4.
17. Use the Fusion Slider to see how the FDG uptake in the lesion corresponds to the anatomy
on the CT.
18. Create a 7 mm radius sphere around the lesion, then open the Auto Isocontouring dialog.
19. Select Set Defaults to use typical 3D Hot settings for PET hotspots. A threshold of 50% of
the Max-Min in the starting sphere VOI is applied.
20. Use the Fusion Slider again to see how the VOI corresponds to the CT anatomy.
21. Additional suggestion – try creating isocontour VOIs with a range of thresholds (e.g. 30, 40,
60, 70%) and compare them to the CT anatomy.

5.2

S2-exercise 2: Image matching and fused rotating MIP for
presentation
1. When PET/CT data is not already coregistered, rigid matching methods (rotations and
translations) can be used.
2. Load the PET and CT series for mouse_7 from the BrukerPCI database.
3. Once the Hybrid workflow has completed, it is clear that the PET and CT are not properly
coregistered.
4. Select the Matching tab, then the Reference & Matching page from the menu in the top
right.
5. Select the Input Reslicing shortcut. Manually translating the PET into approximate alignment
with the CT is easy for the user and provides a better starting point for the automatic rigid
matching algorithm. Drag the PET into approximate alignment with the CT using the central
white square of the reslicing controls. Rotations are not necessary.
6. Change the Species to Mouse (Rat is detected due to the large FOV/volume of the CT
series), and the matching method to Rigid.
7. Deactivate the Reslicing controls by selecting the General Image Manipulations tab.
8. The field-of-view for the CT is larger than necessary and the mouse is not centered. For an
attractive rotating MIP movie it is worthwhile to crop the CT, removing unnecessary data
and centering the mouse in the new field-of-view.
9. Expand the Crop Reference dialog using the blue circled arrow next to the workflow buttons.
10. Once the Crop checkbox is activated a blue crop box is displayed on the image.
11. Drag the center of the crop box to approximately the center of the liver (check all three
planes)
12. Click Match Current and accept Cropping.
13. The bounding box is cropped and the coregistration improved.
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14. Explore the coregistration result using the Image Display and Fusion Controls.
15. Using the Save icon on the right lateral toolbar, save the cropped CT and coregistered PET
back to the database.
16. Proceed to the Comparison tab using the workflow button in the lower right.
17. Then proceed to the MIP tab using the MIP workflow button.
18. The MIP tool allows fusion of up to three images, denoted A, B, C. The combination of
images displayed can be set using the red/green icon in the lower left, and the plane used
for display set on the right under the slice preview.
19. Select the ABC+F layout and Y plane.
20. Increase the lower threshold of the CT display (note: the image is not calibrated to HU) until
only the skeleton is visible.
21. Reduce the upper threshold of the PET display to highlight the FDG uptake in the tumor
near the chest.
22. The rotating MIP movie is calculated using the green Run button in the lower right. If the
result does not play smoothly the number of angles can be increased using the menu
immediately left of the Run button.
23. Once calculated the MIP rotates continuously. The color tables and thresholds can be
adjusted without having to recalculate.
24. The movie can be captured using the Filmstrip icon in the lower center, then the familiar
Save Video dialog is opened when rotation is restarted using one of the white Play arrows.
As in the previous Section, a continuously looping GIF is convenient for embedding in
Powerpoint.
25. Start the video and save it to an appropriate folder.

5.3

S2-exercise 3: CT-based brain spatial normalization and VOI
atlases
In human neurology research the use of standardized brain VOI atlases is commonplace.
Application of these VOI atlases relies on matching of images from an individual to a template image
that has the same “image space” as the VOI atlas. Ideally, individual and template images should be
from the same modality, for same tracer/sequence. In human studies, the high size-to-resolution
ratio for brain PET makes PET templates effective, even with different imaging hardware. In small
animal studies the size-to-resolution ratio is limited, and brain PET images can have very little
anatomical shape (even more so for SPECT). Although PET templates are available for rat/mouse
brain, experience shows that variations in imaging protocol, imaging hardware and reconstruction
make their application challenging. To get around this limitation, the creators of atlases and
templates have also included anatomical MR templates. However individual MR for each animal in a
study is not widely available, and the need for 3D T2-weighted images of sufficient quality can be
prohibitive even when a center has MR. In contrast, many centers have PET/CT and routinely
acquire CT data even for brain-only studies for attenuation correction. We are developing rat and
mouse CT skull templates in the same image space as the built-in VOI atlases. The hybrid nature of
the PET/CT data allows a transformation for spatial normalization of the individual CT to a template
to be directly used on the PET data, allowing standardized, reproducible, brain VOIs to be used for
PET quantification. Note that many brain templates, whether PET or MR, are averages of spatially
normalized images from several subjects. This can help to remove minor regional variations and
left/right asymmetry, but obviously requires researchers to have images from several normal
subjects (ideally outside of the study population), and a template/VOI atlas that these subjects can
be registered to. Another very effective approach is to use a single, good quality, subject image as
the study template, and either define VOIs specific to the study goals on that image, or adapt a VOI
atlas to that image. In the example below an individual rat CT that matched the Schiffer VOI
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atlas/template with only rigid transformations was chosen as template. A new CT from a PET/CT pair
is spatially normalized to this template, allowing the Schiffer VOI atlas to be applied to the PET data.
1. The hybrid FDG PET/CT data from rat_4 in the BrukerPCI database will be used to
demonstrate spatial normalization of the CT and application of the same transformation to
the PET.
2. If desired, check the coregistration the PET/CT pair using the Hybrid workflow described
earlier in this Section.
3. Open the Fuse It Configuration and set the Default Matching to Deformable.
4. On the DB Load tab, select only the 100um CT from rat_4 and Open. When a single series
is selected for loading it will automatically be assigned to Input Image.
5. As we are only interested in the brain, cropping can be applied to reduce the image size
and increase processing speed. This will also make it easier to get an initial overlay of
individual and template CTs. Expand the Cropping dialog using the blue-circled arrow
immediately left of the Deform workflow button.
6. Check the Crop checkbox to show the crop box in the Image Display.
7. Adjust the crop box dimensions to 34 / 28 / 50 mm, and click in the center of the brain to
center the crop box on this location.
8. Proceed using the Deform workflow button and accept cropping.
9. Load a Reference image using AUTODETECT.
10. Navigate to the folder USBdrive:/Pmod-trial/Pmod/data/CT-template and select the file ratCT-template-wip.hdr. Load.
11. The field-of-view in the template image is deliberately limited, excluding as much information
outside the skull as possible. The initial rotational misalignment is clear. Use the shortcut on
the right-hand toolbar for Input reslicing, then rotate and translate the Input CT into
approximate alignment with the template.
12. Check that the Species is correctly set to rat (due to the small volume of the cropped
image/template it can change to Mouse), and that the Matching method is correctly set to
Deform (the normalization algorithm settings can be viewed by clicking on the grey/orange
multimodality icon).
13. Start the spatial normalization using the Match Current workflow button.
14. On the Matching Result page the result can be readily assessed by displaying contours for
the template. Activate Contours in the fusion controls and select B. Move the Fusion Slider
to the right to see how the contours correspond to the skull in the template image. Then
move the Fusion Slider to the left to compare the skull in the transformed Input Image to the
contours.
15. Save the transformation to the database for application to the PET data (e.g. as CT-toCTtemplate.mat).
16. Return to the Load Input Images page, and load the FDG PET WB for rat_4.
17. Adjust the crop box as before and proceed using the Deform workflow button.
18. The PET is displayed in overlay on the CT Reference, but we will not calculate any
matching in this part of the workflow.
19. Using the green workflow arrow, proceed to the Matching Result sub-page.
20. From the Load Transformation dialog, select the transformation just saved.
21. Use the Fusion Slider to inspect the result.
22. Proceed using the VOIs workflow button.
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23. Rather than using the VOI definition tools seen so far, we will now load the pre-defined rat
VOI atlas created by Schiffer and colleagues.
24. From the Template tab, select Atlas, then Px Rat (Schiffer) from the list of atlases. A preview
of the atlas VOIs is shown in the Image Display. In order to use the VOIs for quantification,
they should be Outlined onto the images. The atlas VOIs are organized in a tree structure,
and a subset of VOIs to suit a specific study goal can be selected for outlining, rather than
automatically using all 58 available regions.
25. For now, Outline all available VOIs, then inspect the result by moving the Fusion Slider to
show only the PET, and deactivate the contours from the Reference.
26. Atlas VOIs are generalized, but can be applied reproducibly. Users may modify atlases in
PMOD and introduce their own if they are not fully satisfied with those available as
standard.
27. Using Selected Statistics, calculate the Average and SD for all of the atlas VOIs.

5.4

S2-exercise4: Direct PET-based brain spatial normalization
and VOI atlases
With an appropriate distribution of the tracer, and the right templates, direct matching of brain PET
data to a PET template is also possible. This is also a solution for the many standalone PET
scanners still in use around the world.
FDG is a good example of a tracer where direct PET to PET template matching is possible. In this
exercise we will use built-in FDG PET templates to spatially normalize a dynamic rat brain FDG
scan. Then atlas VOIs can be used to reproducibly extract time-activity curves for kinetic modeling.
The output from this exercise will lead you directly into Section 4 Exercise 1.
1. Kinetic modeling starts with the extraction of time-activity curves from dynamic PET data. If
we want to use brain atlas VOIs to do this, we can use the Fuse It tool.
2. First we can set the default workflow to Deformable.
3. Then Load the Dynamic PET WB [brain crop] series for subject rat_3 from the BrukerPCI
database. This cropped version of the dynamic whole-body PET was created in Section 1
Exercise 6.
4. Adjust the upper color table threshold to 500, and select the last frame. The accumulation of
FDG in the brain and longer late frames result in better image quality. An even better
average for matching to the template can be created by averaging some later frames. In
this case an average of frames 20-23 works well.
5. Check that the Species selection is rat. With cropped images the volume can be low
enough to be identified as mouse.
6. Select the Deform workflow.
7. On the Reference & Matching page we can select the template to be used. We have two rat
brain FDG templates available, corresponding to the Px Rat (Schiffer) VOI atlas and
Schwarz VOI atlas. Select the Px Rat (Groningen) FDG template.
8. Start the Deformable matching workflow using the Match Current workflow button. The
transformation calculated using the average image will be used to normalize the dynamic
image once we are happy with the result.
9. Once the calculations are complete, we can assess the result using the fusion controls.
10. Creating a contour for the outline of the template, and comparing it to the normalized
individual is often helpful.
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11. The result is acceptable, so we can save the transformation to the database to avoid having
to repeat the calculations if we reanalyze this animal.
12. The transformation can then be applied to the original dynamic data using Apply Current
Transformation to All. This will take some time since there are 23 frames.
13. Once that’s complete we can proceed to the VOIs page.
14. We can switch to the dynamic PET using the list of Input images in the lower right.
15. Then we can select the Px Rat (Groningen) VOI atlas from the Template tab, and Outline all
of the VOIs. This will also take some time depending on the performance of your computer.
16. There are two options convenient transfer of the time-activity curve from each VOI to the
Kinetic Modeling tool.
17. When you will proceed directly with modeling, the Kinetic Modeling button calculates the
curves and allows direct transfer into the Kinetic tool.
18. Alternatively, the curves can be calculated using the more general Statistics button, and the
curves saved in PKIN TACs format. This is a file that can be loaded from the menu in the
Kinetic tool.
19. Save the PKIN TACs file to the BrukerPCI database so that it can be loaded for Section 4
Exercise 1.
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6

Section 3: 3D Rendering (P3D)
3D rendering can yield eye-catching presentation images. PMOD’s 3D tool allows surface and
volume rendering of data from all modalities, as well as rendering of VOIs. A dedicated
segmentation interface allows particular tissues to be extracted and the segments to be organized
before rendering. Multimodality data from the same subject can be combined, including application
of 4D textures to show tracer kinetics. Many data types require some preprocessing to improve the
3D rendering outcome. CT data benefits from masking of the animal bed and tubes used for
anesthesia/monitoring. PET data (including hybrid data) should be resliced to the same matrix as an
anatomical reference (CT/MR). This is readily achieved using the Fuse It tool. Protocols can be
saved so that rendering projects can be restored for further work and adjustments.

6.1

S3-exercise 1: Simple CT surface/volume rendering with
VOIs
1. The basic principles of the 3D tool are easiest understood using a single input image. We
will combine surface and volume renderings from the same CT dataset and add a VOI to
highlight a lesion.
2. Open the 3D tool and select mouse_6 from the BrukerPCI database.
3. The PET WB and CT WB series are the original data from the scanner. We have prepared
cropped and masked versions of the data to improve the 3D rendering result (i.e. removal of
bed and anesthesia tubes from the CT, masking of high activity in the bladder from the
PET). The cropping and masking was achieved using the techniques described in Section
1. They are omitted here to save time (CT clean-up requires iterative masking steps).
4. Select and load the CT WB [CROP] [MASKED] series and Load.
5. After loading, processing starts on the Segmentation page. The image is displayed in the
Input tab, top left. In the lower section, thresholding and other segmentation methods are
available on the left, and either the image histogram or a list of segments prepared are
shown on the right. The histogram can be used as part of threshold definition (as can the
Data Inspector in the Input Image Display).
6. CT is useful for an initial demonstration as certain tissues can be readily segmented by
finding voxels with values above a particular HU threshold.
7. Enter a threshold of 500 HU and click the orange Segmentation button.
8. The voxels above the threshold are displayed in the Current tab, top right. Turn on the MIP
for the Current tab Image Display. If the threshold was correct for detection of the bones,
the MIP should closely resemble the skeleton.
9. Save this voxel selection for rendering using the Add Segment button (green). The selection
is added to the Segments tab in the lower right.
10. Select the entry in the list on the Segments tab, then click Set Segments 3D Rendering
Properties.
11. In the Edit Segment dialog, the rendering type can be set using the radio buttons, the color
set for surface renderings, and a name defined. The skeleton will be rendered as a surface,
in white, and the name “skeleton” can be entered.
12. Click OK to close the Edit Segments dialog, then click the Render Selected workflow button
in the lower right.
13. The resulting rendering can be rotated using the mouse (left click, drag) and zoomed using
the mouse wheel or dedicated slider on the Scene, Views, tab.
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14. On the Scene tab, Views sub-tab, the Background Color can be adjusted.
15. On the Scene tab, Rotation sub-tab, rotating movies can be started, and saved by activating
the Filmstrip icon as seen in Section 1. During movie recording the scene can be
interactively rotated and zoomed.
16. The Capture icon on the right lateral toolbar allows 2D captures to be saved in a range of
formats.
17. Additional renderings can be appended to the overall scene.
18. Return to the Segmentation tab.
19. Change the segmentation mode to In Range and enter lower/upper thresholds of 0/500 HU
to segment soft tissue. Click Segmentation.
20. Add Segment to the Segments list, then set its Rendering Properties to Volume HD, Color:
Gray, named soft_tissue.
21. Activate the Append pin immediately left of the Render Selected workflow button, then
Render Selected.
22. The rendering is updated and shows the surface rendered skeleton and new soft tissue
volume. The entries for the two segments are listed in the View tab in the top right.
23. Select VR soft_tissue. The color transfer function is shown in the lower right. Drag down the
horizontal bar to increase the transparency of the volume segment.
24. Explore the rendering using the mouse and try to identify the tumor on the right side of the
chest. We can highlight it by rendering a VOI previously defined in the View tool using the
PET information.
25. Select the Input tab in the top right.
26. Select the tumor VOI from the BrukerPCI database using the Browse icon right of the text
No VOLUME OF INTEREST.
27. Using the menu arrow to the right of the workflow button, select VOIs [Surface], then
confirm rendering.
28. The VOI is rendered and displayed.
29. Explore the overall rendering using the mouse and try capturing a rotating movie.
30. Save the Protocol for the rendering project to the BrukerPCI database.
31. Suggestion: See how the saved Protocol can be used to restore the project after clearing all
data from the 3D tool.

6.2

S3-exercise 2: Fused PET/CT rendering
1. A combination of surface rendered skeleton from CT with volume rendered PET is pleasing
for PET/CT data. VOIs can still be added as in the previous exercise, and elements of the
skeleton can be trimmed away to reveal details from the PET. For example, the top of the
skull can be trimmed to reveal tracer uptake in the brain.
2. Clear the previous data in the 3D Rendering tool.
3. Open both mouse_6 CT WB [CROP] [MASKED] and PET WB [CROP] [MASKED]
[RESLICED]. Note – this version of the PET/WB was loaded together with CT WB [CROP]
[MASKED] in Fuse It and the resliced version, thus with the same matrix dimensions as the
CT, saved.
4. On the Segmentation tab, select the CT, then Segment voxels above a Threshold of 500 HU.
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5. Add Segment to the Segments list, and set its 3D Rendering Properties to Surface, Color:
White, Name: skeleton.
6. Render the skeleton.
7. Next, return to the Segmentation tab and select the PET using the menu arrow below the
Image Info for the Input tab.
8. Segment all voxels above a Threshold of 5 units (i.e. the units have not yet been set to
kBq/cc in this series).
9. Add this general body segment to the Segments list, and set its 3D Rendering Properties to
Volume HD, Color: Cold, Name: PET.
10. Make sure that Append mode is active, and Render the PET volume.
11. Initially the volume rendering of the PET is dominated by background body voxels and the
organs with higher uptake are not prominent.
12. Select VR PET, then the Volume tab.
13. Increase the transparency to 0.5 and set the top of the profile range to approx. 80%.
Observe the effect of these changes on the PET rendering (allow some processing time).
14. Change to the Input tab and select the tumor VOI available in the database.
15. Append a surface rendering of the VOI to emphasize the lesion.
16. Select the tumor entry on the View tab and add approx. 50% transparency to the VOI
surface using the slider on the lower VOI tab.
17. Finally, we will trim the top of the skull to reveal the PET tracer uptake in the brain and
Harderian glands.
18. Select Planes, and Add an Oblique plane.
19. Click and hold the tail of the arrow through the oblique plane and drag it to an angle that will
trim the skull without trimming the spine – this will likely be an iterative process!
20. Next, click and hold the plane to move it until it transects the top of the skull.
21. Select the skeleton SR in the Scene panel, then the Cut tab.
22. Uncheck Arrow Side, then select Cut (allow some processing time for this step).
23. Select Plane 1 in the Scene list and uncheck Visible to reveal the trimmed rendering.
24. Explore the scene and capture a rotating movie.
25. Save the Protocol for the rendering project to the BrukerPCI database.
26. Suggestion: See how the saved Protocol can be used to restore the project after clearing all
data from the 3D tool.
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Section 4: Kinetic Modeling (PKIN)
Kinetic modeling is a crucial part of fully quantitative PET. It allows us to go beyond radioactivity
concentrations, standard uptake values and percentage of injected dose. Instead we can extract
physiological parameters such as blood flow in ml/min/ml tissue, glucose metabolism in
umol/min/100g tissue or receptor density, where the non-displaceable binding potential is often
used.
Kinetic modeling inherently accounts for differences in injected dose, body weight and differences
in physiology that influence the tracer kinetics. If performed well, it can help reduce variability in
experimental results and improve statistical power.
Acquiring good data for kinetic modeling means attention to detail, and gold standard compartment
modeling requires blood sampling to get the arterial plasma tracer concentration over time and to
account for metabolism of the tracer in the body. We have an application note dedicated to blood
sampling that is available on our website.
The dynamic PET needs to be started before the tracer injection, to capture the initial delivery of the
tracer to the tissue-of-interest. The measurement should also be long enough to capture the washout
phase. For FDG studies of glucose metabolism a 1-hour measurement is typical. The image is
normally reconstructed with short early time frames to describe the rapidly changing activity
concentration, then increasingly long time frames.
Time-activity curves are extracted from the dynamic data using VOIs. Standardized atlas VOIs are
often used for brain studies, and PMOD’s fusion functionality provides a clear step-wise workflow to
use them. Image fusion, templates and atlas VOIs were covered in Section 2.

7.1

S4-exercise 1: Gold-standard two-tissue-compartment PET
kinetic modeling with an arterial input function –
full-quantification of cerebral glucose metabolism
For this example we will use dynamic FDG PET data from a rat imaged on the Bruker Albira SI. An
arterial whole blood input function has been adapted from another animal to demonstrate
compartment modeling. The blood data was measured with high temporal resolution using a
swisstrace twilite coincidence detector, and literature values for the conversion of whole blood
concentration to plasma concentration will be used. 2-tissue compartment modeling will allow us to
extract glucose metabolism in umol/min/100g tissue, as well as to separate glucose transport from
metabolism.
1. We will start this exercise using the time-activity curves generated in Section 2
Exercise 4. In that exercise we normalized the rat 3 FDG brain PET data to a PET
template and extracted the time-activity curves using atlas VOIs.
2. The time-activity curves were saved in PKIN TAC format, so that they can be loaded
from the main menu in the Kinetic modeling tool.
3. This menu is accessed in the lower-left, and we can find the time-activity curves using
Load Tissue TACs.
4. Select FDG-PET-atlas-VOIs and Open.
5. A warning message tells us that blood data must still be loaded to fit compartment
models. The TACs are organized according to a list in the top right. The model can be
configured independently per region, or applied to all regions simultaneously. The next
step is to load the blood data that we need for the 2-tissue compartment model.
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6. Load the whole blood file FDG-activity-in-whole-blood from the main Kinetic menu >
Load Whole Blood Activity. The preparation of blood files for use in PMOD is described
in our online Documentation.
7. The plasma input function can then be calculated from the combination of whole blood
tracer activity and a fraction describing the ratio between plasma and whole blood
concentrations over time, by loading the corresponding FDG-conversion-WB-toplasma-activity via the Kinetic menu > Plasma/WB Fraction > Parent. Metabolites in the
blood are not a significant problem in FDG studies, so a parent fraction is not
necessary.
8. The blood data and fraction curve can be viewed on the Blood tab. Radio buttons for
Whole Blood, Plasma and Metabolites reveal the associated data. After unchecking the
display of the blood curves, the plasma/WB fraction shows us that initially the tracer is
predominantly in plasma, with an increasing presence in red blood cells later in the
study. PMOD automatically corrects the whole blood curve to account for this
distribution, and uses the resulting total activity in plasma curve for the model. Imagederived input function methods often neglect these corrections.
9. An important concept in studies with external measurement of the tracer activity in
blood is a difference in timing between the PET data and blood data. This is known as
the Delay. This represents the time it takes the blood to leave the body along the
catheter used, before activity reaches the detector. We can enter a reasonable starting
value for the Delay on the Whole Blood tab. Enter a value of 20 s.
10. Now that we have the final blood data, we can perform modeling with a representative
TAC. Select Cortex_Motor_Left from the list of regions, and select the 2-Tissue
Compartments, FDG model. Activate k4, so that we can test the common assumption
that it can be set to zero.
11. A first model fit can then be tested by clicking Fit Current Region. Using iterative
methods, PMOD finds rate constants for the model that produce the best agreement
between the blue model curve and the measured PET data. Relative error in these
estimates is shown to the right of the resulting rate constants, and the residuals between
model and PET curves are shown in the lower plot window.
12. The actual glucose metabolism rate calculated is dependent on the Lumped Constant, a
parameter that represents the transport difference between FDG and glucose, and the
plasma glucose concentration at the time of the study. The Lumped Constant is usually
taken from the literature, but the plasma glucose should be measured in each subject.
13. The Delay can also be included in model fitting. This may improve the reliability of the
model results. From the menu below Fit Region, Fit Region & Blood can be selected.
After fitting, a blood delay of around 15 s is estimated. This value can be inspected on
the Blood tab.
14. The changes of the parameters using the different fitting options are best inspected
using the Show History button. Mathematical criteria such as the Akaike Information
Criterion (AIC) and Schwartz Criterion (SC) can be used to identify the best model.
These indices are available on the Tissue Details tab. Small values indicate a better fit.
15. We can try setting k4 to zero and refitting the model in this region.
16. The model curve doesn’t follow the data as well as when k4 is considered. The History
reveals that there is also a large difference in the glucose metabolism result, and allows
us to go back to the previous model result by double-clicking that line in the table.
17. The model and these reasonable values for the rate constants can now be transferred
to all other regions for fitting across the brain. Use Copy to All Regions, Model and
Parameters.
18. Now we can Fit All Regions.
19. The modeling results can be summarized using the View Parameters button. From this
dialog the results table can be Copied To Clipboard for use elsewhere.
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20. Finally, the entire PKIN analysis can be saved via the Kinetic menu > Save KM File in
order to resume analysis later.

7.2

S4-exercise 2: Reference-tissue-based kinetic modeling –
receptor density with the non-displaceable binding
potential (BPnd)
Reference-tissue kinetic models were developed to avoid the complexities of collecting blood data
for classical compartmental models. However, there are critical assumptions that must be carefully
considered. The reference tissue must be completely devoid of the tracer target, yet have very
similar tracer delivery and washout to the target region. In this way the reference tissue TAC
provides the information about tracer delivery to the target tissue that would otherwise be provided
by the blood data, allowing the two-tissue compartment model to be simplified. In small animal PET,
even when a reference tissue is available, it may be compromised by spill-in of activity from
adjacent regions that express the target or have high non-specific uptake.
11C-raclopride is a tracer targeting dopamine D2/D3 receptors, which are densely populated in the
striatum in rodents. Dopamine receptors are widely studied due to their role in the mechanism of
action for antipsychotic medication and implication in diseases such as Parkinson’s. The
cerebellum is routinely used as a reference region for non-specific binding in studies of dopamine
receptors, as immunohistochemistry and autoradiography studies demonstrate a lack of receptors
in this region.
In this example of 11C-raclorpide PET in a rat we will use VOIs from an atlas-based workflow to
extract striatum and cerebellum time-activity curves and perform reference tissue-based kinetic
modeling.
1. Open the View tool and select rat_7_external from the BrukerPCI database. We will extract
time-activity curves from the dynamic PET |> Matched to T2_TSE3D [Cropped] series.
2. We are expecting to see high tracer uptake in the striatum, with almost no specific uptake
elsewhere in the brain. An average image can improve image quality and reveal the specific
binding. Create an average of frames 30-39, and turn on the MIP display. This reveals the
striatum and Harderian glands.
3. We have provided atlas-based VOIs for this example. They can be loaded from the
BrukerPCI database where they are saved as Raclopride-atlas-regions-MR-space-forcropped. They were created by matching the T2_TSE3D MRI in the database to the Px Rat
(Schiffer) template. Then the striatum and cerebellum VOIs were transformed into the
individual MR space.
4. On the average image it’s easier to see how they correspond to the striatum. You can load
the MR image and compare them to the anatomy if you want.
5. For now, we can switch to the dynamic PET, then calculate the time-activity curves for
kinetic modeling.
6. Set the Model Selection to Reference and use Send[Add] to transfer the TACs to PKIN and
simultaneously create a new workspace.
7. Select Simplified Ref. Tissue SRTM from the Model List. The documentation for each model
in the list can be called up using the question mark icon next to the model name.
8. On the Tissue tab, select the striatum_R as target Region, and select cerebellum as the
Reference region.
9. Click Fit Current Region.
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10. The blue model curve is updated and the fit results shown on the right.
11. Change the target region to striatum_L and fit the SRTM there as well.
12. The results for both regions can be viewed in parallel using View Parameters.
13. Note the difference between left and right striatum.
14. Save KM File so that it’s easy to return to the project later or share your results with others.
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Section 5: Parametric Mapping (PXMOD)

8.1

S5-exercise 1: Maps of dopamine D2/3 receptor density
using reference-tissue-based modeling
Parametric mapping is the application of kinetic modeling in every image voxel of a dynamic PET
series. This creates new 3D images in which the voxel values directly represent a quantitative
parameter from the model. For example, instead of kBq/cc or SUV per voxel in an FDG PET, the
result of parametric mapping could be an image with quantified glucose metabolism
(umol_glucose/min/100g_tissue) per voxel. Beyond interesting image presentation, parametric
mapping allows image-wise averaging, subtraction, etc. within study groups or for longitudinal
measurements for single animals. This allows clear visual representation of treatment/pathology
effects and supports statistical parametric mapping (voxelwise statistics in the same style as
functional MRI). In this exercise the calculation of parametric maps of glucose metabolism will be
described. Patlak graphical analysis will be used. This efficient method linearizes the time-activity
curve in each image voxel and the arterial input function, making fitting fast and reliable. The plasma
glucose concentration is needed to convert the fit slope in each voxel to glucose metabolism.
1. Start PXMOD and select MRGlu (FDG Patlak) model in the workspace tab list. By selecting
this model, the configuration requirements are adjusted accordingly.
2. Additional information about this model and its implementation can be found in our online
Documentation (see Section 9).
3. Define the image data using the Input Data Settings button in the Image Data tab of the
workspace. In the new dialog window make sure that Input1 format is Database then use
the file browser button to select the Dynamic PET WB [brain crop] series from rat_3 in the
BrukerPCI database for loading. Use the Reset loading parameters button to be sure that
no pre-processing will be applied. Select OK to open the image. (The Load button is used
when working with pre-saved protocols).
4. Use the red Masking button to proceed. In the next step we will define a mask of the brain in
order to limit the modeling calculations to the voxels we are interested in (i.e. within the
brain).
5. Creation of an average image that resembles the whole brain can aid threshold-based
masking. Such an average can be created from a time range where tracer concentration is
high throughout the entire brain. For 18F-FDG this is late in the study when the tracer has
been trapped in brain tissue. Set the frame range to 20-23, and create the average image
using the Aver button.
6. The brain is visible as the mid-range of activity in the average image. Therefore selecting
voxels in a certain range of kBq/cc might create a good mask. Use the Data Inspector to
assess the values in the brain, as well as outside the brain and in the Harderian glands.
Values in the brain seem to range from 100 to 300 kBq/cc with values in the Harderian
glands exceeding 300 kBq/cc. Change the segmentation method to Range and set the
thresholds to 100 and 300. Create a preview of the mask using the Segmentation button.
7. The resulting mask has a rough outline, but successfully excludes many voxels outside the
brain. The mask should be saved to the database for later use in the Protocol.
8. Proceed using the Modeling workflow button. The program switches to the Modeling/Model
Preprocessing panel, skipping the time-activity curves step. The Patlak model can be fit in
every voxel selected by the mask using only a fixed t* value and the blood data. A pilot
analysis in the Kinetic modeling tool can be used to find a good value for t*. See Section 4
Exercise 1 for an example of Patlak modeling in the Kinetic tool with this data.
9. First we need to provide the blood data. This should be the arterial plasma tracer
concentration throughout the dynamic PET measurement. For this data we had the whole
blood concentration and a fraction to convert that concentration to plasma values. When
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that was done in the Kinetic tool the resulting plasma concentration curve was saved for this
parametric mapping. Now it can be set as DB TAC, selecting FDG-calculated-activity-inplasma from the BrukerPCI database.
10. Proceed using the Preprocess Blood workflow button.
11. Here we simply see the blood data, before proceeding again using the Configure Model
Preprocessing workflow button.
12. Target tissue can be deactivated, and the t* checkbox unchecked. The t* can be set to 15
min based on our prior knowledge from the Kinetic modeling tool.
13. The individual plasma glucose is entered on this page.
14. Start preprocessing using the Preprocess Model workflow button. When no target tissue
was used the Results tab is empty, only confirming the fixed t*.
15. Proceed using the Configure Target Maps workflow button. The check boxes indicate which
maps will be calculated.
16. The last configuration step is now completed and the pixel-wise calculation can be started
using the Start Pixelwise Calculation workflow button.
17. The resulting parametric map of glucose metabolism can be explored using the Data
Inspector. Note the quantitative units.
18. The maps can be saved in one of the available formats (e.g. back to the Database for best
study organization) using the Save icon on the right lateral taskbar, or using the Save Maps
button in the Parametric Maps panel. During the saving process, PMOD adds the parameter
name to the series description or to the specified file name, depending on the output
format.
19. We highly recommended saving the full processing configuration in order to retrieve all the
processing details later. After retrieving a Protocol the settings can be edited, and the
processing relaunched. Save the configuration of the current Patlak analysis using the
Save Protocol button in the status line.
20. To test the configuration, open a new PXMOD workspace, load the configuration settings
using Load Protocol and let it Execute.
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Section 6: Automated Image Segmentation (PSEG)

9.1

S6-exercise 1: Automated organ segmentation with
dynamic PET/MR
Segmentation plays an important role in image assessment. Manual and semi-automated VOI
definition approaches can be subjective and lack reproducibility. They can also be very timeconsuming. Semi-automated methods that allow the user to carefully control the threshold were
described in Section 1. While these methods provide a more objective approach they typically use
a single time point or average image. The PMOD Segmentation tool uses a licensed algorithm to
directly analyze the dynamic PET or SPECT data, and apply clustering based on voxels with similar
kinetics. In small animal PET, particularly mouse whole body PET, this can be used for automated
organ segmentation. In a final stage, the user assigns VOIs to the detected segments.
1. In this exercise, automated organ segmentation will be performed for mouse dynamic FDG
PET data. MR is available for anatomical reference.
2. Open the Segment tool from the main PMOD toolbar.
3. Select mouse_8_external from the BrukerPCI database, then add both the MR anatomy and
dynamic PET matched to MR to the Selected for Loading list. Open the images.
4. Processing is performed on the next tab. Its title changes depending on the workflow
selected. The workflow itself is selected in the third step of the workflow. We will use the
Functional (Local Means) workflow.
5. The Functional (Local Means) workflow is divided into four pages: PET loading, CT/MR
anatomical reference loading, Mask generation, Segment labeling.
6. The PET image selected during DB Load is automatically assigned to the PET page. On this
page an average is calculated from the dynamic PET, and there is then a fusion display of
the dynamic and average images. The average will be used for masking if there is no CT or
MR available, or if it results in a better whole-body mask than CT or MR (e.g. due to bed
hardware or artefacts). It can also be used while labeling identified segments later. For
masking, the PET average should result in an image with activity visible in the whole body.
This would likely be an average of the first few minutes after injection. For segment
identification, the average should result in an image with activity visible in the most
interesting organs.
7. For this example with FDG, an average between frames 4 and 17 is useful for masking and
also for segment identification.
8. The Species should be automatically detected as Mouse. Although we have the MR, the lack
of signal in the chest area means it is not ideal for masking (since there is FDG uptake in
the heart that we wish to segment). Change the Masking Method to PET Whole Body.
9. Proceed using the + CT / MR workflow button. This takes us to the CT / MR page where we
can verify the coregistration of PET and MR (i.e. if the series are not properly coregistered,
the Fuse It tool should be used to register and save a new coregistered PET), before
proceeding using the Create PET Mask workflow button.
10. On this page the resulting mask from the average PET is shown in red, overlaid on the PET.
It can be compared to the average PET using the fusion functions, and edited if necessary.
The whole-body PET method results in a good mask in this example.
11. The segmentation method is then chosen in the orange menu panel. We will use Functional
(Local Means). More information about the methods can be found in our Documentation.
12. The algorithm considers the differences between FBP and Iterative image reconstruction.
Select Iterative for this PET data.
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13. The half-life of the tracer is detected automatically for DICOM data from the database. For
other formats you may need to check this.
14. Set the defaults for Segments (100) and Reduction (30), but change Smooth to Inveon. The
spatial resolution is considered in the segmentation algorithm. When a limited number of
organs for segmentation are expected, the number of Segments may be reduced. For
dynamic PET series with many time frames, Reduction may be used to limit the number of
those frames used in the algorithm. This may reduce processing time, or avoid the
influence of late noisy frames.
15. Proceed using the Segmentation workflow button.
16. On the Segments page we see a fusion of the MR anatomical reference and the
segmentation result. The display of segments from the result is adjusted using the Segment
slider in the lower right (this slider mirrors the slider on the Segments set of image controls).
17. Start at the lowest complexity, with the slider moved all the way to left.
18. Only a whole-body segment is shown in the Image Display.
19. Increase the Segment slider to 2. A new segment is shown, that appears to correspond to
the bladder. Use the fusion controls to compare the segment to the MR.
20. Since the segment appears anatomically correct, we can assign a VOI to it. Right click on
the segment in one of the planes of the Image Display.
21. A VOI definition dialog appears, in which standard organ names can be selected for each
VOI. There is a dedicated set of names for Small Animal. Select Bladder from the list and
confirm using Create / Replace.
22. This process is repeated iteratively. The Segment slider is advanced, then new segments
are investigated and labeled if anatomically meaningful.
23. At Segment level 3 a segment for the heart is shown. Label it as Heart > Whole.
24. At Segment level 6 segments for the kidneys are shown. Zoom in and use the fusion
controls to compare the segments to the kidneys in the MR. Label them as well.
25. A 3D whole body mouse atlas (Digimouse) can be loaded using a shortcut on the right
lateral taskbar. It uses PMOD’s 3D functionality to render VOIs for major organs. The VOIs
can be switched on an off to help understand the mouse anatomy.
26. Using the menu above the Segment slider, the fusion display can be changed to show
either the dynamic PET (PET), the average PET (AVR), or the CT/MR (CT/MR).
27. Select PET, then select the final PET time frame on the first set of image controls in the top
right. Use the fusion controls to compare the segments and the tracer uptake in the PET.
The bladder, heart and kidneys segments compare very well.
28. At Segment level 8 a segment is shown in the testes area, corresponding to high uptake in
the PET. This is not expected in healthy animals. Label the segment as Tumor > HotSpot.
29. Additional VOIs can always be added using the standard VOI tools. Additional VOIs could
be based on either the PET or MR.
30. The TAC for the selected VOI can be previewed on the second tab above the Segment
slider, then the statistics for all VOIs can be calculated using the Stats workflow button.
31. On the Statistics tab the TACs can be saved, or sent to the Kinetic Modeling tool. Averages
for defined time ranges can be calculated using the tools below the Curve Display. The
results may also be directly converted to SUV if the information required is in the image
header.
32. At the end of processing we recommend Saving the Protocol. It can be stored in the
database for easy retrieval when the analysis should be reproduced. It can also be used to
reload the data and settings used, before changing certain settings and re-running the
processing.
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33. Additional suggestion – try using the MR for masking. Do you find the gap in the mask for
heart and lungs?
34. Additional suggestion – try the Functional (Local Means) workflow on the dynamic PET WB
series for rat_3 in the BrukerPCI database. There is no anatomical data available, so
masking should be performed on the average of the PET data. Use the Rodent smoothing
setting (1.5 mm) and otherwise Default settings. It is possible to segment kidney and heart.
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11.1 S8-exercise 1: Creating a new database for a new project
As illustrated by all of the exercises in this workbook, PMOD includes the ability to organize all types
of data into databases. Images in the databases are stored as DICOM, and components of
processing, such as VOIs, TACs, protocols, are saved using our formats. The database
functionality is available in all PMOD installations at no extra cost. Databases allow data to be clearly
organized by studies/projects, and annotation within the database interface can help with treatment
group labeling. Additionally, data within the database can be associated to greatly facilitate batch
processing (e.g. association of PET/MR pairs for automated brain analysis). The database storage
structure in the PMOD file system also makes backup and archiving of data and processing results
convenient. After standard installation, two databases (Pmod and Demo) are available (here we use
the additional BrukerPCI database). In the following exercise a new database is created and some
data sets “Replicated” between the BrukerPCI database and the new database.
1. Open the Users Configuration from the main PMOD toolbar.
2. Select the DATABASE tab, then select Add new data source (it may be necessary to use
the menu drop down from Duplicate data source).
3. Use the name ExampleDB.
4. Make sure that Use Direct Connection is selected to use the embedded Java database.
Defaults are used to fill in the entries defining the path for the database files (Database
Path) and the actual data files (File Storage Area Path). These default locations are within
the PMOD installation folder, however you can also separate the database location from the
installation folder to allow easier version updates and backup schemes.
5. Activate Create Database to create the database tables. A confirmation message appears,
stating that the database creation was successful (note – on Mac and Linux creation can be
blocked due to folder access permissions. Contact us for Support in such cases).
6. The ExampeDB is now shown as the visible entry in the data sources list.
7. PMOD requires a restart to make the new ExampleDB available in all tools. Quit the Users
Configuration with Ok. In the Save Configuration dialog window enable Quit Pmod to restart,
then wait for PMOD to restart.
8. Open the View tool, and select the new ExampleDB entry in the database selection.
Naturally it is empty.
9. Data can be directly transferred from one database to another using Replication. In this
way an Import database and separate databases for Projects could be used.
10. Select the BrukerPCI database, then select the PET WB series for mouse_1. Add it to the
Selected For Loading list.
11. Expand the Export menu in the lower left and select Replicate.
12. In the green colored database selection menu, select the new ExampleDB, then Start
Replication.
13. A confirmation message confirms whether Replication was successful.
14. Accept the message, then switch to the ExampleDB. The mouse_1 PET WB is now visible.
15. Alternatively, new data can be directly imported from DICOM or other image formats, or
can be loaded for quality control before saving to Database in the usual way.
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Section 9: Online Documentation of PMOD and
Requesting Support
Beyond this workbook, comprehensive documentation for all of the PMOD tools is available via our
website. The list of documentation can be found via the Resources > Documentation menu. For
each part there is a choice between HTML structure, which includes navigation on the left-hand side
and many links between items, and a downloadable PDF. The PDF can also provide access to
simple searching using your own PDF reader software.
Support from our Application team is also available for your specific questions. Your support
requests can be submitted through the interface within the PMOD software, or via our website.
Via the Support > Support Request menu on our website you will find instructions for direct support
via the software Console interface, as well as a form to submit your request if email via the software
is blocked by your institution.

12.1 S9-exercise 1: Access to further Documentation and
Support
Please see www.pmod.com
Resources > Documentation
Support > Support Request
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